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Introduction
Dreamweaver is a powerful web development tool.  But new
users often find getting started with Dreamweaver to be a
daunting task.  The purpose of this guide is to get you up
and running with Dreamweaver MX quickly.  In fact, you
will likely have a web site up on the Internet by the end of
your second session. Once you become acquainted with
Dreamweaver, you’ll find it is also a very easy tool to use.

With this guide you will learn how to construct your own
personal web site.  While any reason would do, this guide
uses the project of constructing an electronic portfolio re-
flecting your personal and professional experiences.  Like
any portfolio you will be able to show evidence of your pro-
fessional experiences, skills, and interests.  Because the port-
folio will be web-based, anyone in the world who has access
to the Internet and a web browser (such as Netscape or
Internet Explorer) can visit it, including family and friends,
colleagues, teachers, and prospective employers.

This guide is presented in four sessions:

1) Creating a “root folder” for your web site on your
computer and defining a local web site in
Dreamweaver;

2) How to construct a new HTML document from
scratch;

3) How to link your HTML document to other web
pages; and

4) How to add graphics and backgrounds to your HTML
documents.

Each session is designed to be completed in one sitting (no
more than one hour), though the actual completion time will
vary from person to person.

This guide was written to go along with Dreamweaver ver-
sion MX.  Please be aware that there are many important
differences between this and earlier versions of
Dreamweaver.

I designed this guide
for educators, hence
I use educational
examples
throughout.
However, the guide’s
basic structure to a
portfolio is relevant
to any professional
or student.
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How to use this guide

In each section, you will be asked to perform a series of
steps to complete the project.  Each step to be performed
will be preceded by a check box, such as this:

Select “Preferences” from the “Edit” menu.

Follow the instructions carefully and check off the step when
it is completed.  This will help you from getting confused
and disoriented.  In the event that you make a mistake,
these check boxes will help you to retrace your steps.
Explanations and illustrations will accompany these steps.
The illustrations represent what you should actually be
seeing on your screen.  You should strive to ensure that
critical elements of illustrations match exactly what you
see on your screen.

However, you will encounter lots of situations in which
general features of illustrations will never exactly match
what you see on the screen, such as the relative positions
of windows.  The graphical user interface (GUI) of
Dreamweaver results in all kinds of variations that have
no bearing on the final result.  Rest assured that I’ll try to
alert you to those times when absolute accuracy is required.

Of course, it is possible that you will follow and check off
each and every step and still feel hopelessly lost at some
point.  When the inevitable happens, try not to panic.
Instead, carefully retrace your steps starting at the last
point where things seemed to be working.  Try to approach
these situations with the attitude of a creative problem-
solver confronted with a challenge.

What you are expected to already
know

This guide assumes you already understand basic comput-
ing concepts, such as how to create and save files with ap-
plications such as Microsoft Word.  It also assumes you have
been successfully browsing the World Wide Web with appli-
cations such as Netscape or Internet Explorer.

This guide will not teach you everything there is to know
about Dreamweaver — it’s not designed to.  Therefore, after
completing this guide, it is strongly recommended that you
find and use other resources to thoroughly learn
Dreamweaver and its many features.  A good place to start
is the reference manual that accompanies Dreamweaver.
Fortunately, the popularity of Dreamweaver has generated
many excellent third party books as well.
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Copyright Information

This book is copyrighted and is being distributed using the
“shareware” method — you can copy this book without con-
sulting me, but if you use any or all of this book in your
learning or teaching, you are legally obligated to send me
the royalty fee.  If you choose not to use this guide, either
destroy the copies you have made immediately, or give them
to another person to try.  If you were given this guide by a
friend or teacher, you too are obligated to pay for it if you
use it regardless if they sent in their payment.  (Of course,
feel free to log on to my web site and get yourself a fresh
copy!)

The royalty fee as of the date at the bottom of this page is
$10 (US) for educators and students who use this guide as
part of a class at a not-for-profit school and $20 (US) for
everyone else. Send your payment to the following address:

Lloyd Rieber
6114 Nowhere Road
Hull, Georgia 30646
USA

Checks or money orders should be made payable to “Lloyd
Rieber.”  All payments need to be made in US funds.

This royalty fee is subject to change every six months.  If
you obtain a copy of this guide after six months from the
date below, please consult the following web site for the most
current royalty fee amount:

http://www.nowhereroad.com/dreamweaver

I will also update this guide as needed to correct mistakes
and make other improvements, so be sure to get the most
recent version.

I will acknowledge your payment upon receipt.  As a little
extra incentive, I will also send you free-of-charge the URL
of an additional Dreamweaver MX lesson that shows how to
create and use tables in your HTML files, one of the most
useful tricks to improving the aesthetics and layout of any
page.

Remember, if you use any part of this guide and do not send
payment promptly, you and/or your institution are in viola-
tion of copyright.  Please support me in trying to get quality
materials into the hands of people quickly, without hassles,
and at a reasonable cost.  And besides, guilt is a terrible
thing!

Version: March 4, 2003
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Session 1:
Getting Your Computer Ready

for Web Development

Although I’m sure you are anxious to begin designing your
first web page, you’ll actually save time in the long run by
doing a little bit of prep work right away.  First, we need to
create a new folder on our computer that will contain all of
our web work, called the “root folder” for our web site.  Sec-
ond, we will launch Dreamweaver and immediately define
our web site using this root folder.

Preliminary

This guide is being written for students who most likely
will be working in a computer lab at school. For that reason,
it’s recommended that you store all original files associated
with your web site on removable media, such as a floppy or
zip disk. It will be easier and less confusing to transport the
files easily between school and home. (Of course, it will be
important to back up our files from time to time.)  If you are
not going to be working between school and home like this,
you can simply choose to create a new folder on your home
or office computer, as per the instructions that will follow,
instead.

Format a new disk dedicated to web page
construction.

We will start by creating a folder that will contain all of our
web work, not just the portfolio web site built by going
through this guide.  As explained more fully in Appendix A,
this folder will eventually correspond to a folder on the web
server on which our site will reside after we upload (i.e. trans-
fer) the files.  Dreamweaver will use the terms “local” and
“remote” to refer to the files either on our computer (i.e. lo-
cal) or the files uploaded to a web server (i.e. remote).

Beware!  Go slow
and check off all the
boxes as you
complete the steps.
You’ll save time by
taking your time and
making sure you
understand each
step.

It doesn’t matter if you
use a floppy disk, a zip
disk, or some other
form of removable
media, but your choices
may be limited to the
computer you are
using. Keep in mind
that floppy disks, due to
their limited storage
size, will fill very quickly,
especially if you start
using lots of graphics,
sounds, etc.
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Make a new directory on this disk and name it
“My local web files”:

Next we create a folder exclusively for our portfolio web site.
As you will see, this folder will contain every file and graphic
pertaining to our portfolio.

Make a new directory on this disk and name it
“portfolio”; type in all lower case letters:

It’s a good idea to give some thought to the overall design of
our web site, such as its main parts or functions.  Although
we will not deal with how to insert graphics or images into
our web pages until Session 4, it’s a good idea now to plan
for their eventual need. A good strategy is to create sepa-
rate directories for any resources we may be using.

The portfolio directory
is your “root directory ”
for your entire web site.
This means simply that
everything related to
your web site must be
contained within this
directory. The
importance of this
concept will be
emphasized throughout
this guide.

The screen shots in
this guide were
taken from the
Windows XP version
of Dreamweaver
MX. Fortunately, the
differences between
the Macintosh and
Windows versions
are slight, so
Macintosh users
should have no
problem using this
guide. When
differences are
important (such as
control-clicking
instead of right-
clicking), they will be
pointed out.
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Open the portfolio directory and make another
directory inside it called “images”:

Great! We have created the essential first elements of our
web site! Time to launch Dreamweaver MX.

Launching the Dreamweaver MX
Application

Launch the Dreamweaver MX application.

Windows users: Click on the Start button and launch the
application:
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Macintosh Users: Find and double-click on the
Dreamweaver MX application icon:

If this is the very first time you’ve launched Dreamweaver
after installing it, you will see the following window:

The Dreamweaver MX interface is significantly different
from the Dreamweaver 4 interface. This window gives you
the option of using the older interface or using the “new and
improved” MX interface.  The rest of this guide uses the MX
interface, so that’s what we want.

Be sure that “Dreamweaver MX Workspace” is
checked, then click OK.

You will not be bothered by this window from here on, al-
though you can manually access it in the Dreamweaver pref-
erences.

The only reason to
choose the
Dreamweaver 4
Workspace would be if
you are a diehard
version 4 user who
strongly prefers that
interface.
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Again, if this is the first time you’ve launched Dreamweaver
since installing it, the following window will open:

If you have the time, feel free to explore some of the infor-
mation available on this welcome screen. Assuming you just
want to push ahead, close the welcome window.

Close the Welcome window by clicking once in
the close box in the upper right corner.

A blank screen appears with the title “Untitled Document”:

There are several windows and panels that open automati-
cally. The most important for us are those labeled above:
Document Window, Property Inspector, Insert Bar, and the
Site panel. There are many, many more windows and pan-
els that can be opened as well! We’ll explain and use these
windows as we go.

Insert Bar

Property Inspector

Site panel

Panel groups

Document Window

You can always come
back to this welcome
window later by
choosing “Welcome”
under the Help menu.
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Setting up a web site

I know you are just itching to get started building a web
page with Dreamweaver, but let’s do one more thing first.
One of the most powerful features of Dreamweaver is its
site management tools.  Not only does this greatly simplify
and shorten the time it takes to maintain a complicated web
site later, but setting up a site now will give us access to
many unique tools and opportunities even while we are
building our first pages.

There are two main parts to the process of defining a web
site within Dreamweaver:  Setting up a local site and set-
ting up a remote site.  Before you can set up the remote site,
you have to have access to a web server, either provided to
you via your school or company, or one you pay for.  We will
not worry about setting up the remote now, but we will spend
a few minutes now setting up the local site.

Notice the “hot text” in the site panel that reads “Define a
Site”:

All we need to do to start the process of defining a site is to
click on this hot text.

Click once on the hot text “Define a Site” in the
site panel.
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This triggers the site definition wizard — a step-by-step
guide to defining a site.  The first page simply asks you to
give your site a name.

Give your site the name “My Portfolio Web Site”,
then click “Next>”:

The next page asks if you want to use a server technology. A
server technology allows you connect your web site to an
online database for applications such as a guest book, shop-
ping cart, etc. We will not be using a server technology in
this guide.

You can choose any
name you want for this
— this site name is only
used internally by
Dreamweaver to keep
track of all of the sites
you set up.  This name
will never appear
anywhere later on the
Internet.
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Choose “No, I do not want to use a server
technology”, then click “Next>”:

The next page asks two things:  How you want to work with
your files during development and where the files are lo-
cated. We will choose to work locally on our personal com-
puter, then upload to a server when ready:

The second part ask us to tell Dreamweaver where, exactly,
our files are located on our computer. We need to point to
the directory we set up at the beginning of this session.

Be sure that the first choice (“Edit local copies
on my machine...”) is checked, then click on the
small file folder icon:

Click here

Be sure the first
choice is selected.
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Navigate your way to the directory “My local web
files” and be sure it appears at the top of the
window:

Click “Select”.

Be sure the path to this directory appears in the window:

Great! We’re almost done. Just one more step.

Recall that I created
my root folder on a
zip drive, which is
the D: drive on my
computer. If you are
also using a zip
drive it may have a
different letter.
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Click “Next>” to go to the network connection
page of the site definition wizard.

The network connection page assumes you have a live con-
nection to a web server. However, at this point we are going
to assume that you do not yet have access to a web server,
so we will tell this to Dreamweaver. If you do have access to
a web server and want to finish, you can go to the Appendix
for the “rest of the story”.

Click on the small black triangle to the right of
“Local/Network” to activate the pop-up menu and
choose “None”:

Your screen will look like this when finished:
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Click on the “Next>” button.

Review this summary page. If you feel you made a mis-
take along the way, you can click the “<Back” button to
retrace your steps.

If all looks well, click on the “Done” button.

Notice that the site panel now reflects your site. It mirrors
how the disk is organized with your site’s root folder:

Great! We are all set to build our first web page!
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Session 2:
Constructing a new HTML

Document

Dreamweaver provides an easy way to construct web pages
without having to learn Hypertext Markup Language pro-
gramming, more commonly known as HTML.  Instead, we
can use Dreamweaver like a word processor.  There are some
key differences between Dreamweaver and word processors,
however.  One of the biggest differences you will notice later
is how graphics are handled.  You can also use Dreamweaver
to easily link one web page to another.  In this session, you
will learn how to construct a single web page from scratch.

Entering and formatting text

Let’s begin building a personal home page by typing a short
biographical statement about yourself.

Type your name, followed by a brief statement
about yourself, patterned after the following:

Also notice the four phrases I typed at the end.  Later, these
topics will act as a menu where each topic links to a sepa-
rate web page.  We will learn how to construct links to other
web pages in the next session.  The use of organizing text,
such as this simple menu, is a good first step to designing
your web site.

Obviously, you
should type your
name and
information about
yourself here
instead!

Dreamweaver allows
you to view and modify
the raw HTML code that
it automatically
generates as you use
its “point and click”
interface.  If interested,
you might find this a
good way to learn
HTML.  However, many
people build quite
sophisticated web sites
with Dreamweaver
without ever having to
deal directly with
HTML.

Notice that when you
press the RETURN or
ENTER key, there is
automatic double-
spacing between
paragraphs.  This is
standard.  (You can
press Shift-Enter to
start typing on the very
next line.)
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It’s also a good idea to type a “title” for your home page. This
title will appear at the top of the browser window when
people access your page.

Type something like “Lloyd Rieber’s Home Page”
in the window beside “Title:”

Saving your page to disk

Like working with any file, it’s important to save early and
often. Saving here is as easy as with any other application.
However, it’s very important that the name of the file be
given special consideration. Some web servers are case sen-
sitive, so we need to pay attention to our use of lower and
uppercase letters (we’ll stick to all lower case). We also need
to avoid using special characters and spaces. Finally, all web
files must end in one of several special extensions. For ex-
ample, we are going to name our first file a very special
name called “index.htm”. We’ll explain in a moment why
the name  “index” is being chosen.

Select “Save as...” under the “File” menu.

Save your file to the “portfolio” directory  on your
disk with the name “index.htm”, such as the
following:

Click “Save.”

When someone
accesses your web site
on the Internet, this title
will appear at the top of
their browser window. If
they bookmark your
site, this title will be the
name of their
bookmark.
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Home pages for web sites are typically named “index.htm”
because this is a very special file name for web browsers.
When you enter a web site without pointing to a specific
file, the web browser looks for a file named “index.html” in
that directory. If found, it displays it. This is a nice way to
keep web addresses a little simpler to remember. For ex-
ample, the address for my personal web site’s home page is
“http://www.nowhereroad.com/index.html”. However, you
can just type “http://www.nowhereroad.com” and it still
works.  There are other special names as well, such as
“default.htm” or “home.htm”, but “index.htm” is the stan-
dard on most servers.

Notice that your page appears in the site panel window:

You’ll use this site panel window to open and manage all of
your Dreamweaver files.

Let’s turn our attention back to the content on our page.

Continue to type additional text as you would in
a word processor. Be sure to save often as you
go.

You might add some additional topics to your menu, such as
“My Educational Philosophy,” or “Instructional Materials I
Have Developed”. You know, topics that might be found in a
professional portfolio.

Formatting text

The procedures for formatting your text are similar to those
of any word processor.  However, the choices are limited to
only the format options supported by HTML.  You will also
need to get familiar with the HTML terms for formatting.
For example, the format for standard text is called “Para-
graph.”  Let’s change the format for the first line containing
our name.  Let’s put our name in large letters centered on
the screen.

Like any word processor, the first step is to highlight the
text you wish to format.

Highlight your name by clicking, holding, and
dragging the mouse over the letters in your
name.

Actually, the extension
“.htm” or “.html” can be
used.  Windows users
traditionally use the 3
letter extension and
Macintosh users
traditionally use the 4
letter extension. We’ll
refer to both as HTML
files throughout this
guide.

You’ll find the choices
quite limited as
compared to a word
processor.

Click on this symbol
to expand (+) or
collapse (-) the
directory.
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Next, we need to change this text from “Paragraph” to “Head-
ing” with the largest text available.

Select “Heading1” from the “Format” menu in
the Property Inspector:

Next, click on the “center” symbol (be sure the
text is still highlighted).

When done, your name should be correctly formatted:

You will get more accustomed to the peculiar formatting
options as you work more with Dreamweaver.

Click on this symbol to
center your highlighted
text.

Property Inspector

You can also add
color to your text by
clicking here.

You can change fonts
here. However, be
careful because if the
end user does not
have a particular font
installed on their
computer, the default
system font will be
substituted.
(Remember, too, that
users often choose to
override a page’s
fonts with their own
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Adding a horizontal rule

A good way to separate sections of a web page is with a
simple graphic called a horizontal rule.  Let’s insert two
horizontal rules — one after your name, and one  right be-
fore the menu choices.  First, let’s insert a blank space after
our name.

Click once just before the first letter of the
paragraph containing the short biographical
sketch:

Click once on the horizontal rule button.

Edit your page as you would in a word processor,
formatting it as you wish.

For example, I edited my home page to the following:

Save your file periodically as you work!

The next two sessions will show you how to build links from
one page to another and how to insert graphics into your
web pages.

Horizontal rule
button

Notice I added another
line of text that will be
used to link to a very
useful educational web
site offered by the U.S.
Department of
Education.

Two horizontal rules
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Previewing Your Web Page

Although Dreamweaver does a nice job of showing you what
your page will look like when it is actually “up and running”
on the Internet, it’s helpful to occasionally preview your page
in a web browser of your choice. The shortcut for doing this
is pressing the F12 key, but you have to have at least one
specific web browser identified (up to 20 different web brows-
ers can be chosen). It’s likely that your copy of Dreamweaver
has already chosen Internet Explorer as the default browser.
Of course, this implies that you already have Internet Ex-
plorer installed properly on your computer in a place that
Dreamweaver expects it. In a minute, we’ll explore how to
set up or change your preview browser list, but there is no
harm in just trying it out to see if it works.

Select “File - Preview in Browser - iexplore” from
the menubar, or press F12.
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If it works, Internet Explore will automatically be launched
and your Dreamweaver page will appear in a new window:

If it didn’t work, you may have received any number of mes-
sages, the most likely being that Dreamweaver couldn’t find
Internet Explorer and whether you would like to edit the
preview list.

If Internet Explorer was launched and opened your page in
a new window for you, close this window and go back to
Dreamweaver.

Close all windows except the one containing
your web page in Dreamweaver.

Let’s go through the steps of selecting a web browser. Even
if things worked fine for you when you pressed F12, you
may want to use Netscape Explorer, or at least add it as a
secondary browser.

Select “File →Preview in Browser →Edit Browser
List...” from the menubar:

This brings up the Preview in Browser Preference dialog
box.

Notice that this is an
internet Explorer
window — you are no
longer in Dreamweaver.
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Next, we’ll quickly go through some of the steps to find,
add or delete a browser.

If Internet Explorer did not launch when you
pressed F12 earlier, but you know you have it
installed on your computer, click on the “Edit”
button.

The following dialog box appears:

Click on the “Browse...” button, then navigate
your way to the Internet Explorer application and
choose to open it; Click “OK” when done.

Let’s add Netscape Communicator (or Navigator) to our list
while we are here. Again, this assumes that you already
have Netscape Navigator installed on your computer.

In the “Preview in Browser” Preference window,
click on the small plus (+) sign beside
“Browsers”.

Click the “Browse” button and navigate your way
to the Netscape Communicator application and
choose to open it.

Click in the check box to make this your
secondary browser.

Windows Alert!
A good place to start
your search is in a
directory called
“Program Files” on the
C: drive.

Macintosh Alert!
If you don’t find Internet
Explorer as soon as
you enter your hard
drive, then first look for
an “Internet
Applications” folder,
followed by an
“Applications” folder.

The text beside
“Application” may be
missing or different.
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Your window should look like the following:

Click “OK”.

Your “Preview in Browser” Preference Window should look
like this:

Click “OK” to accept all the changes and to leave
the “Preview in Browser” Preference Window.

Press F12 as often as you like from here on to
preview your web page in your chosen primary
browser.

Save often.

Click here to add a
browser to the list.

Click this button to
browse your computer
for the Netscape
application.
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Follow-up Activity

Practice the skills learned in this session by creating an-
other new Dreamweaver file to contain your professional
resumé.  If you already have a resumé typed into a word
processor, you can “copy and paste” it from the word proces-
sor into Dreamweaver.  Be sure to again save this
Dreamweaver file to your portfolio folder with a title of your
choice (e.g. “resume.htm”).

Here’s an example:

Notice the sentence I included at the bottom — “Click here
to go to Lloyd Rieber’s Home page” — indicating, obviously,
a link back to my home page:

In the next session, you’ll see how to link the two files to-
gether.

We’ll briefly show next how to create a new web page.

Choose “New...” from the “File” menu.

Next, you need to select a new document type:

However, remember
the earlier warning
about the difference in
formatting between
HTML and word
processors.  Even if
you copy and paste
your resume from a
word processor to
Dreamweaver, expect
to spend considerable
time reformatting the
Dreamweaver file.
Fortunately, most word
processors, such as
Microsoft Word, now
provide the option to
“Save as HTML...” The
files you save this way
can then be opened
and refined with
Dreamweaver.

Remember to
include a title for
your page, such as
“Lloyd Rieber’s
Resume”.



Introduction to Dreamweaver MX 27Session 2:  Constructing a new web page

There are lots of choices, but we’ll just be sticking with the
basic HTML page.

Choose “Basic Page” and “HTML”, then click
“Create”.

A new page opens, overlapping any other pages already open:

Obviously, it will be difficult to manage even a small num-
ber of pages open at the same time.  Fortunately,
Dreamweaver MX has a useful feature built into it to help
organize these pages.

Choose to maximize any of the pages now open.

Notice how the pages align themselves automatically.  Each
open page has its own tab you can click to access it:

Click on the “maximize”
symbol of any page
currently open.

Click on one of these
tabs to access any
page.
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Here is my resume page, freshly typed:

Again, in the next session you’ll learn how to link these two
files together.

Taking a Look at your Root Folder

It’s useful to take a look inside your root folder at this point.
Recall that we made a directory named “My local web files”
at the start of session 1 to store all of our web sites.  Then
we created the directory “portfolio” as the root folder for our
portfolio web site. Now that you have created at least two
HTML files, your root folder should resemble the following:

As we finish this session, consider how your entire web site
is now contained within the directory named “portfolio”.  All
the files you add or create, such as HTML files, graphics
(which we will cover in session 4), sounds, etc., will be con-
tained inside your “portfolio” directory.

It’s also a good idea to make a back-up of your root folder
onto a separate disk.

Don’t get bogged down
at this point trying to
create the perfect
resume page with all
the possible information
about you. You will
have plenty of time later
to work on it. However,
be sure to create this
new page with at least
some token information
now — we will be using
this page to
demonstrate how to link
two pages together in
the next section.

Windows Alert!
You might find it helpful
to see the extensions of
all files while working
through the rest of this
guide. To do this, you
will need to turn off the
option to “Hide
extensions for known
file types.” This option
is found in the control
panels:  Go to the
section “Appearance &
themes”, then choose
“Folder Options” and
click on the “view” tab.

Notice that my
HTML files are
associated with
Internet Explorer.
Your HTML files may
be associated with
Netscape instead,
meaning that
Netscape is the
default application
for your “.htm” or
“.html” files. If you
double-click on a
file, your default
application will
launch and then
open the file. To
open these in
Dreamweaver, or
another appropriate
application, you
would have to
launch the
application first, then
open the file from
the application.
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Make a back-up of your “portfolio” directory onto
another disk.

Uploading your files to a web server

Before others can access your web pages, you must upload
(i.e. transfer or copy) all of your files to a web server.  Fortu-
nately, Dreamweaver has excellent site management tools
that make “talking”  to a web server easy (i.e. uploading and
downloading files). These site management tools are cov-
ered in the Appendix. There are also separate FTP applica-
tions that you can also use to do this. FTP stands for “file
transfer protocol”. WS_FTP is the most common Windows
FTP application and Fetch is the most common Macintosh
FTP application.  Here is a good resource for learning how
to use these FTP applications:

http://www.arches.uga.edu/upload.html

However, there is no need to rush.  You can upload your files
at any time and as often as you wish. But if  you are anxious
to get “on the web,” either go through the Appendix now or
learn how to use an FTP application.

It’s important to put
back-ups on drives or
disks other than the
one on which your web
site is currently stored.
You want to make you
can recover important
files if your hard drive
or disk crashes.
Introduction to Dreamweaver MX 29
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Session 3:
Linking to Other Web Pages

As already mentioned, HTML stands for Hypertext Markup
Language.  The prefix hyper- translates best as “linking.”
In fact, one of the most powerful features of the World Wide
Web (i.e. the Internet) is the ability to link any web page
with another.  All you need is the web address (called a “Uni-
form Resource Locator,” or URL) of the web page to which
you wish to link.  Instead of learning all of the HTML com-
mands and programming the web page ourselves (with a
text editor), this session again shows you how to use
Dreamweaver to construct these links.

Preliminary

Let’s start this session by briefly getting reacquainted
with where we ended the previous session. Recall that we
created two HTML documents and saved them inside the
“portfolio” directory, which is likewise located inside the
“My local web files” directory.  The “portfolio” directory is
the root folder for your portfolio web site and the “My local
web files” directory is where you will be saving all of your
web sites. You either created these directories on your
computer’s hard drive or on some removable media, such
as a floppy or zip disk.

Find and open the directory titled “portfolio”:

Obviously, we need to launch Dreamweaver to continue
working on our web site. However, if you are working in a
Windows computer, notice that your “index” and “resume”
files are considered as “belonging” to Internet Explorer on
my computer (as signified per the blue “e”). Therefore, if I
double-click on the file, Windows will launch Internet Ex-

Obviously, if your
portfolio web site is
located on a floppy or
zip disk, you need to
insert that disk first.

“http://www.ford.com” is
an example of a URL.
Later you will form your
personal URL, which
will become your
address on the World
Wide Web.
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plorer instead of Dreamweaver. Your files may be associ-
ated with Netscape instead, meaning that Netscape is the
default application for your “.htm” files. If you double-click
on a file, your default application will launch and then open
the file. We don’t want that. To open these in Dreamweaver
we have to first launch the Dreamweaver application first,
then open the file from Dreamweaver.

On a Macintosh computer, in contrast, the files are identi-
fied as Dreamweaver files and double-clicking on either
will launch Dreamweaver:

However, for consistency between platforms (and to avoid
any confusion), let’s get in the habit of launching
Dreamweaver first, and then opening a file from within
Dreamweaver’s site panel.

Launch the Dreamweaver application.

Your screen should resemble the following:

If you are using the same computer as that in the first two

Site panel
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sessions and the last person to use Dreamweaver, your port-
folio web site will open automatically in the site panel:

If you just started working on a different computer, either
another Dreamweaver site has opened in the site panel
(probably belonging to another person), or you will see the
“Define a Site” hot text indicating that no site has yet been
defined. If either of these situations apply, you’ll need to
first define a site just like you did in Session 1 in the sec-
tion “Setting up a web site” on page 11.

Once you have finished getting your site defined just like it
was at the end of the previous session, proceed to the next
step.

It may not be obvious how to create a new site if a site
other than yours is open. All you need to do is click on the
“Site” menu in the site panel and choose “New Site...”:

From the Dreamweaver site panel, open the file
“index.htm” by double-clicking on it.
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Your screen should now resemble the following:

Linking Your Personal Web Page to
Another Web Page Already on the
Internet

Let’s build our first link to the “Federal Resources for Edu-
cational Excellence Home Page” at the bottom of the page.
We are going to make these words active, or “hot,” meaning
that when a user clicks on them, they will be immediately
taken to this web page.

The first step to making any word, phrase, or sentence ac-
tive or “hot” (i.e. linking to another page) is to highlight the
text.

Highlight the sentence “Federal Resources for
Educational Excellence Home Page” by clicking,
holding, and dragging over the letters of the
words:

Alternatively, you could have clicked on the paragraph tag,
marked “<p>” in the bottom left hand corner. This refers to

A shortcut to
selecting a block of
text is clicking on
one of the HTML
tags located here,
such as the <p>
(paragraph tag). You
will see this list of
tags change,
depending on the
tags at the text
insertion point (i.e.
where the vertical
bar is flashing).
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the text associated with this tag. This is a handy shortcut in
Dreamweaver.

Next, type the web address (URL) in the text box at the
bottom left of the screen (beside the small globe).

Click once in the text window beside “Link” in
the Property Inspector and type the URL for this
web page:

For example, here is the URL for this government web site:

http://www.ed.gov/free/

When finished, press return.

Notice that these words have now changed color and they
are underlined.  This indicates that the text is “hot,” mean-
ing that it will link to another web page when clicked.

It’s also important to tell Dreamweaver where to open this
link. This is called the target. The most typical targets are
the parent window (the new page will replace the old) or a
blank window (the new page will open in its own window).
This is an important decision, as it can be very disorienting
if the user expects it one way and opposite happens. In this
case, it makes sense for the new page to open in a blank
window because the link is “outside” of our web site.

Click on the little triangle beside “target” in the
Property Inspector to show the pop-up menu:

Choose “_blank”:

Type the URL here

Property Inspector

This address is an
example of an
absolute link . We will
contrast this to a
relative link  in the next
section of this session.

Instead of typing
this manually (and
perhaps making an
error), you could
launch a web
browser (such as
Internet Explorer or
Netscape), go to
this web page, and
then copy and
paste this address
from the web
browser to
Dreamweaver.

Pressing return is
just one way to tell
Dreamweaver to
accept this text.
Another way would
be to press the tab
key, or simply to
click on any other
spot in the document
window.

A good rule of thumb is
that all new pages that
are part of the web site
should open in the
same (parent) window,
but links to pages that
are part of other,
separate web sites
should open in a new
(blank) window.

Click here to activate
the pop-up menu.

Be sure “_blank”
appears in the target
window.

Tags are HTML
commands that modify
a screen object (such
as text) or specify an
action (such as a link)
on the HTML page.
We’ll “peek behind the
curtain” at the HTML
code a little later.
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Previewing the Page to Test the Link

We can test this link by previewing the page in Internet
Explorer.

Press F12 to preview our file in Internet Explorer.

Move the mouse over the “hot text” and notice
that the web address now appears in the text
window at the bottom of the screen:

Why stop there? Let’s see if the link really works.

Click on the hot text to go to this government
web site:

The URL of this “hot
text” appears here in
the web browser.

Refer to session 2 for
identifying one or more
web browsers for
previewing
Dreamweaver
documents.

This only works if you
have a live Internet
connection.
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None come to mind?
Try these:

Public Television
http://www.pbs.org

Smithsonian Institution
http://www.si.edu

U.S. Civil War Center
http://www.cwc.lsu.edu/
civlink.htm

World Lecture Hall
http://www.utexas.edu/
world/lecture/

NASA
http://www.nasa.gov/

Bad Science
http://www.ems.psu.edu/
~fraser/BadScience.html

ExploreScience.com
http://
www.explorescience.com/

This is called a
bulleted or
unordered list. To
make it, highlight the
lines, then choose
“Text - List -
Unordered List” from
the file menu.

Notice that this link opened in its own window, due to the
fact that we selected “_blank” for the target.

Have you saved recently?

Select “Save” from the “File” menu.

Find several web pages on the Internet that you
wish to link from your home page and write down
their addresses (URLs) carefully.

If any of the web addresses have even the slightest error
(such as a lower case letter “l” instead of the number “1”),
the link will not work.  A good strategy is to run Netscape
or Internet Explorer while you are using Dreamweaver
so that you can just copy and paste web addresses as you
find them.  This guarantees that the web addresses will
be correct.

Construct “hot text” to link to each of these web sites.

For example, I constructed links to the following web sites:

Linking two Dreamweaver files

Dreamweaver offers an easy way to link one Dreamweaver
file with another.  You must have another Dreamweaver
file already constructed in order to complete this section
(such as the web page you constructed to contain your pro-
fessional resume as discussed in the “Follow-up Activity” in
session 2 on page 25).

There are several ways to do this. We’ll show two, with the
first being the most convenient.  The first step for both is to
highlight the text that will become the link to the second
page.
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Highlight the text “Professional Resume” in the
index.htm file:

Next, we use the “Point to File” icon (it looks like a dart
board) to tell Dreamweaver which file we want this text to
link to.

Click, hold, and drag the “Point to File” target
icon to the resume.htm file in the site panel
window:

Notice the link to “resume.htm” now appearing
in the text box beside “Link”.

Remember the
shortcut of clicking
on the <p> tag?
(Your text cursor
needs to be blinking
somewhere on the
desired text block
first.)

Click, hold, and drag
from here...

...to here.
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It’s important to notice that the usual “http://...” does not
appear. Instead, only the name of the file appears. That is
because the link to “resume.htm” is relative to the file
“index.htm”.  The difference between relative and absolute
links is one of the most fundamental principles in web de-
sign.  Again, this speaks to the importance of a root folder.
Links from one file in the root folder to other files or re-
sources in the root folder are all relative to each other.  When
you type “http://” in front of a URL, the link goes absolutely
to one and only one location on the Internet. When the link
is relative, the root folder can be anywhere on the Internet
— your browser is smart enough to figure out how to deter-
mine the rest of the URL.

Let’s take a moment to study the result:

Notice that the text again changed to blue. Most important,
notice that the relative link to “resume.htm’ appears in the
Inspector Window beside “Link”. This means that when we
preview the link, our web browser will look for a file called
“resume.htm” in the same directory as it had found
“index.html”. We’ll just leave the target empty at this point.

Let’s show a second way to create a link.   This is the stan-
dard “browse for file” approach.

After highlighting the text for the link, you click on the small
graphic of a folder to the right of the text box beside “Link”:

After you highlight the
text for the link, click
here to point to the
page on the disk you
want to link to.

I know this is still
probably as clear as
muddy water — if so,
don’t fret. It will become
clearer as we go.
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A standard file dialog box appears.  Navigate to the “portfo-
lio” directory:

Select “resume.htm’.

Click “OK” to accept the link.

Just so you know, there is a third way you could have cre-
ated this link after highlighted the text — you could have
just typed the name of the file you wanted this text to link
to instead. However, the “Point to File” procedure is prob-
ably the easiest way to link any Dreamweaver file to an-
other, thus facilitating the construction of a complex web
site. But, no approach is wrong if it works!

Let’s save the file before we test the link.

Save your file.

OK, let’s see if the link works by previewing the page in
Internet Explorer.

Press F12 to preview the page in Internet
Explorer.
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Your screen should resemble the following:

Click on the link to “Professional Resume”; the file
“resume.html” from your disk should appear in the browser
window:

Cool!

Of course, we’re a little stuck right now because there is no
obvious way to get back to our home page. Fortunately,  we
have already designed the text to get us there at the bottom
of this page. All we need to do is go back to Dreamweaver to
set up another link there to take us back. No problem!

Close the Internet Explorer window and select
the Dreamweaver window.
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Choose to open the “resume.html” file by double-
clicking on it in the set panel:

Highlight all the text beginning with “Click here
to go to...” at the bottom of the page.

Click, hold, and drag the “Point to File” target
icon to the index.htm file in the site panel
window:

The URL link should show “index.htm’:

Again, you could just
type the name of the
file you wish this text to
link to in the text box
beside “Link” —
“index.html’ in this case.
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Let’s save the file before we test the link.

Save your file.

OK, let’s see if the link works.

Press F12 to preview this page in Internet
Explorer.

In Internet Explorer, scroll down and click on this
link to test it.

If you followed the steps properly, this link should take you
back to your home page (i.e. “index.htm”).

You can now toggle back and forth between these two pages
at will while previewing them within Internet Explorer!

Looking “Behind the Curtain” at the
HTML Code

This is a nice opportunity to take a look at the raw HTML,
the actual code that actually makes the page work.

Close all Internet Explorer windows and go back
to Dreamweaver.

Click on the tab to view the file “index.html”.

Scroll down the page and click once somewhere
inside the text “Professional Resume”.

Notice that another HTML tag has appeared: <a>

As always, be sure to
save each file you are
working with
periodically. Remember,
selecting “Save” from
the “File” menu only
saves the file whose
window is currently
active (e.g.
“resume.html” in this
case). It is common to
have more than one file
window open at a time,
and it is easy to forget
about unsaved changes
to other file windows
currently open, but not
active.

Notice that a third
HTML tag now
appears: <a>
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The <a> tag is used to identify hyperlinks. If you click on
the <a> you will find that it too highlights the same block of
text as does the <p>. That is because both tags modify the
same text.

Let’s “peek behind the curtain” to see what actual HTML
code goes along with this <a> tag. Dreamweaver makes it
easy.

There are three buttons on the left hand side of the tool bar:

We have been in the “Show Design View” all along. But, let’s
click on the “Show Code and Design Views” button to get a
split screen of the HTML code and the document window.

Click on the “Show Code and Design Views”
button.

You can now explore your file from two vantage points at
the same time:  HTML code and the WYSIWYG document
window.

If you haven’t already, click once on the <a> tag
at the bottom of the document window.

This highlights all of the HTML associated with this tag.
We are not going to try to teach HTML coding at this point.
But take some satisfaction in knowing that Dreamweaver
converts each and every key press and mouseclick into the
proper HTML code for you. As you develop your web design
skills, you’ll almost assuredly have a need to learn more
about HTML code. So, also take some satisfaction in know-
ing that Dreamweaver will make it easy for you to live and
work in “both worlds”.

WYSIWYG — what you
see is what you get

Show Design View

Show Code View

Show Code and
Design Views
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Again, be sure to save each file you are working with peri-
odically. Remember, selecting “Save” from the “File” menu
only saves the file whose window is currently active (e.g.
“resume.html” in this case).

Save each file after first making its file window
active.

Make a back-up of your “portfolio” directory onto
the hard drive of your personal computer.

Upload your files to a web server  (see Appendix).

Launch a web browser (i.e. Netscape or Internet
Explorer) and review your pages from the server
to make sure they are working properly.
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Session 4:
Adding Graphics to Your Web

Pages

Graphics are a very popular feature of the World Wide Web.
When used appropriately, graphics add an important ele-
ment to your web pages.  However, graphics can take up
large amounts of memory and require much longer to down-
load over the Internet than text. There is nothing more an-
noying than having to wait several minutes for a single web
page filled with unnecessary graphics to load.  Remember
also that too many graphics, especially when designed poorly,
can easily distract a person’s attention away from the im-
portant ideas you are trying to communicate in your web
pages.  Use graphics prudently to enhance your web site.

A little background about graphics
on the web

It is important to understand how and where graphics are
stored in web pages in order to successfully complete this
session.  Unlike regular word processing files, graphics are
not contained directly inside an HTML document, but in-
stead are stored as separate files on the disk.  An HTML file
merely “points” to the place where a graphic is stored on a
disk.  If found, the graphic is then loaded into the computer’s
memory and the graphic appears on the screen inside your
browser’s window.  If not found, an empty block is shown
instead.  If the path to the graphic is somehow broken, the
graphic will not appear.

Another important fact about graphics on the web is that
they have to be saved in one of a few very special file for-
mats.  The two most common graphic file formats are GIF
and JPEG.  Both file formats compress the graphic so that
it takes up as little space as possible when it is transmitted
over the Internet.  The GIF format is probably the most
common (and one of the oldest) and was introduced by
CompuServe as a way to help its subscribers transmit graph-
ics.  JPEG files allow greater resolution than GIF.  The only
file format we will work with in this session are GIF files.

Web pages load one
page at a time.
Therefore, instead of
designing one long
page with many
graphics, consider
breaking the page up
into a series of smaller
pages linked together.

The path to the graphic
file can be broken
either by later moving
the file or changing the
file’s name.

GIF stands for
“graphics interchange
format.”

JPEG stands for “joint
photographic experts
group.”
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Preliminary: Finding Already
Existing GIF and JPEG Files

Before we can add graphics to our web pages, we first have
to find some GIF or JPEG graphics. This guide does not
teach how to create your own, though it is not very difficult.
Most of the graphics applications available today allow you
to create and save your graphics in the GIF and JPEG for-
mats. Even the simple Paint program that comes free with
the Windows operating system has this feature. On the
Macintosh side, the drawing and paint features of
AppleWorks have this feature. But if you find yourself need-
ing to do a lot of graphics development work for the web,
buying programs such as Adobe PhotoShop or Macromedia
Fireworks will be a good investment.

So, where can one find existing GIF and JPEG images? For-
tunately, there are literally hundreds of web sites that give
away  web resources such as GIF and JPEG files for free.
At the end of this session is a listing of several of the best
ones. But, just to get us started with some consistency, I’ve
put a small collection of GIF files on the Internet for you to
download and copy. It is perfectly legal for you to copy and
use these on your web site.

Download a sample of GIF files to be used in this
session from one of the following URLs.

Windows users:
http://www.nowhereroad.com/dreamweaver/gifclipart.zip

Macintosh users:
http://www.nowhereroad.com/dreamweaver/gifclipart.sit

Both “.zip” and “.sit” files are compressed and are unusable
until they are uncompressed. The two most common appli-
cations to do this on a Windows computer are WinZip and
EnZip. On a Macintosh, Stuffit Expander is the most com-
mon. (Your computer may be set up to do this automatically
— if so, just pay attention to where the files are being saved
and uncompressed.)

Uncompress the files and put the resulting “GIF
clip art” directory on your computer’s desktop.

Open the directory containing the GIF files in
preparation for copying them to your root folder.
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The following window should be open on your desktop:

Copying These GIF Files to Your
Root Folder

The next step is a very important!  You have to copy (or
move) all of these GIF files to your root folder. If you fail to
do this properly, the graphics will not appear when you up-
load your site to a web server even though they may appear
when you test your pages locally.

Select all of the contents of the GIF clip files and
copy or move them into the “images” directory
inside your “portfolio” directory on your disk.

The site management
features of
Dreamweaver contains
several utilities to
prevent mistakes like
this from happening.
When you have a site
set up properly,
Dreamweaver will
“notice” if a graphic you
are about to use is
inside or outside of your
root folder. If outside, it
will ask you if you want
to copy to your root
folder. Very convenient!
(Again, instructions for
how to set up a remote
web site are contained
in the Appendix.)
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When done, your “images” directory should contain the fol-
lowing:

Now we are ready to use these GIFs in our web site!

Adding Already Existing GIF Files to
Your Web Pages

Dreamweaver makes it very easy to insert GIF files directly
into your pages with the Insert Image button — the tree —
on the Insert Bar:

Again, it is very important that the GIF files you want to
use are already located in the root folder of our web site
before using the Insert Image button.  The reason is that
Dreamweaver simply makes a reference to the graphic file
when you use this button.  If it is not already located in the
appropriate folder, you may break the link when you copy
your web site to the web server.  If you followed the last
series of steps correctly to download the small clip art col-
lection, followed by correctly copying them to your “images”
folder, you should be ready to add any of those GIF files to
your web site.  Let’s consider an example to clarify this.

Launch Dreamweaver.

As always, if you are working on the same computer as you
did the previous sessions and you are the last person to have
worked on Dreamweaver, your portfolio web site will come
up automatically.  If this is not the case, you will again need
to define a local site, as described in session 1.

Insert Image button
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Open your home page “index.htm”.

We simply now need to choose where to insert an image on
this page.   Let’s add a little flair to our home page by plac-
ing little red apples on either side of our name.

Move the cursor to the point where you want to
insert the GIF file and click once.

The text insertion point (blinking vertical line) should be
blinking just in front of your name:

Click once on the Insert Image button in the
Objects Palette.

The “Select Image Source” window opens.

Navigate to the GIF file named “apple.gif” inside
the “images” directory:

Notice the URL of this graphic (“images/apple.gif”). This
translates into “starting at the root folder, you can find this
graphic inside of the images folder with the name apple.gif”.

Click “OK”.

The text insertion
point should be right
here

If this file is not there,
then you did not copy
the GIF files to your
images directory
correctly.  Take the time
now to repeat the
preceding steps
correctly.

You know, kinda like
an apple for the
teacher!
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Here is the result:

Notice a couple of things. First, the apple graphic has handles
around it which allow you to easily resize it. You can also
easily move it to any other location on this page just by drag-
ging it.

The second thing to notice is the source location of this file
in the Property Inspector. It should not be surprising that
this again is listed as “images/apple.gif”.

Repeat the procedure to place another apple
graphic on the right side of your name.

When done, your screen should resemble the following:
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Although you see two apples, there is really still just one
apple stored on the disk. The computer is smart enough to
make its own copy of the graphic on the screen. This saves a
lot of file space. You could place thousands of these apple
images on your page and still only need to have one copy on
the disk.

Here’s another example. I wrote the following at the bottom
of my home page.  Notice where the cursor is blinking.  This
is the place where the graphic will be inserted.

Move your cursor to the point where you want to
insert the GIF file.

Click once on the insert image button.

In the “Select Image Source” window, navigate
to the file named “undrcnst.gif”.

Click “OK”.
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The graphic you selected appears in your page.  Again, since
this graphic is stored in your root folder, the graphic and
the link to it will be available when the folder containing
your web site is copied to the web server.

Select “Save” from the “File” menu.

Adding a background to your web
page

The final technique we will show is how to add a textured
background to your web page.  This will help give your web
page a distinctive “feel.”  Any GIF file can be used also for a
background graphic.  The graphic will be automatically du-
plicated and “tiled” behind the existing text and graphics
on your web page.  For example, we will use the GIF file
named “paper1.gif” — it looks like textured paper.

To use this background graphic on our web page, we need to
access the Page Property window.

Select “Page Properties...” from the “Modify”
menu.

Alert!
Be very careful in
choosing backgrounds.
The wrong choice can
turn your web page into
a disaster!
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The Page Properties window opens:

This window has a very interesting assortment of proper-
ties you can modify, all of which will modify the look and
feel of your web page. For example, this is the place where
you can change the background color or the default text color.
However, our goal is to change the background so that it
has the textured look of paper.

Click on the “Browse...” button to the right of
“Background Image.”

This also opens the “Select Image Source” window.

Navigate to the file “paper1.gif” in the
“backgrounds” directory (located in the
“images” directory in “portfolio”):

Click “OK”.

Like all graphics, a
background is stored as
a separate GIF (or
JPEG) file on the disk.
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This sends us back to the Page Properties window:

Notice the path to this image: “images/backgrounds/
paper1.gif”

Click “OK”.

The page has been transformed to appear as though the
text and graphics are on a piece of paper.

Save your file.

Make a back-up of your “portfolio” directory onto
the hard drive of your personal computer.

Upload your files to a web server  (see Appendix).

Launch a web browser and review your pages.

Any GIF or JPEG file
will work! You could
even choose a JPEG
containing your photo
— I don’t recommend
this design, but if you
want to see yourself on
the web, this is
probably the most
exaggerated way to do
it!
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Graphics Resources

There are lots of web sites where you can get free-to-copy
graphics to use in your web pages. Here are just a few:

The Clip Art Connection
http://www.clipartconnection.com/
One of the largest on-line clip art collections.

Free Backgrounds
http://www.bsugraphics.com/backgrnd.htm

Animated Clip Art
http://webclipart.miningco.com/msub2.htm

Remember, you can find your own resources by entering
keywords, such as “free gif clip art”, at any of the major search
engine sites (e.g. www.yahoo.com, www.altavista.digital.com,
and www.google.com).
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Appendix:
Getting Your Web Site on the

Internet
If you completed two or more sessions in this guide, you are
probably anxious to actually get your HTML documents and
related files (such as images) on the Internet so that you,
colleagues, prospective employers, family, and others can ac-
cess them.  Your web site is not really on the web until all
the files have been correctly transferred to a web server.  This
step can only be done if you have direct access to the web
server onto which your web pages will be stored.

It is assumed that you have at least completed Session 1 of
this guide.  Recall that in Session 1 you defined a new web
site for your site’s local root folder.  This Appendix will guide
you through the rest of the process of defining a site, spe-
cifically that dealing with how to define the “remote” con-
nection to a web server.  When completed, you will easily be
able to upload and maintain all of our web work on the web
server.

Let’s take a closer look at some of the fundamentals of ac-
cessing documents on the web.  For example, a web address
(i.e. URL) is just the path name to the HTML file starting
with the name of the server.  For example, the name of the
web server in the Department of Instructional Technology
at UGA is “it.coe.uga.edu”.  The HTML file is often buried
deep within a series of folders (i.e. directories) indicated by
a back slash (/) in the web address.  For example, consider
the following web address:

The HTML file (“dreamweavermx.htm”) is located in a folder
named “workshops,” which is located in an account named
“lrieber” on the web server named “it.coe.uga.edu”. The tilde
symbol (~) right before the account name serves the same
purpose as an apostrophe in the word “can’t” — it signifies
an abbreviation of part of the actual web address.  Schools
that provide web accounts to its students frequently use
account names such as these.  Fortunately, you do not need
to know anything more about the use of the tilde, if your
web address needs one, other than to make sure that it is
part of the web address.  If you are instead paying for a web
hosting service through one of the multitude of web hosting
companies, the account name is usually omitted.

All of your web work will need to be placed in a special folder
on the web server hidden from public view.  Typical names

web server
(i.e. computer)

name

account
name

folder
name

HTML
document

it.coe.uga.edu/~lrieber/workshops/dreamweavermx.htm
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for this folder include “public_html”, “www”, or “wwwroot”.
If the name of this folder is not readily apparent in the docu-
mentation provided to you by your web hosting administra-
tors, then you’ll need to check with them for this informa-
tion before you will be able to set up your web site with
Dreamweaver.

There can be several ways to upload, or put, your files onto
a web server. If you have direct access to the web server, you
could just put in your floppy or zip disk and copy the files
directly to it.  However, it is much more likely that you have
no idea where the web server is physically located.  There-
fore, the most common way to upload files to a web server is
through FTP, which stands for File Transfer Protocol. FTP
defines a standard for transferring files between computers
at a distance.  The powerful thing about FTP is that the
procedures even work if the computers on either end are
Windows, Macintosh, Unix, etc. As long as each has the ap-
propriate FTP capability and there is a way to connect the
two computers (such as via a phone line), it will all work.

Site management is one of the most powerful features of
Dreamweaver.  Built-in to Dreamweaver is a large assort-
ment of FTP capabilities.  Without these capabilities, you
would have to use a separate FTP application. WS_FTP is
the most common Windows FTP application and FETCH is
the most common Macintosh FTP application. If you are
already familiar with either of these tools, you can continue
to use them. However, once you experience the site manage-
ment features of Dreamweaver, you will probably wonder
how you ever got along with them.

If you are completely new to site management and have
never uploaded or downloaded anything via FTP software,
the good news is that you can start immediately with
Dreamweaver and let it handle virtually all of your FTP
needs.  It is even possible that you may never need to use
any other FTP application. However, it is still to your ad-
vantage to become familiar with an FTP application and to
have it on hand for occasional use.  There are also many
good guides already available on how to use them. For ex-
ample, there is a nice overview of both tools at the following
web site:

http://www.arches.uga.edu/upload.html

Editing Web Sites Created with
Dreamweaver

Again, it is assumed that you have at least completed Ses-
sion 1 of this guide.  We will now turn out attention to edit-
ing the site you created there called “My Portfolio Web site”
to define the “remote” connection to a web server.

FTP — File Transfer
Protocol



58 Introduction to Dreamweaver MX Appendix:  Getting Your Web Site on the Internet

Launch Dreamweaver.

As always, if you are working on the same computer as you
did the previous sessions and you are the last person to have
worked on Dreamweaver, your portfolio web site will come
up automatically.  If this is not the case, you will again need
to define a local site, as described in session 1.

You will probably have a blank “untitled document” opened
for you. That’s fine. We don’t need to open any files associ-
ated with our web site to continue.

From the site panel menu, select “Site − Edit
Sites...”.

This opens a small dialog box listing all of the available
sites (besides the site you set up earlier, you may also see
some samples sites that come along with Dreamweaver):

You can also get
there by choosing
“Site” from
Dreamweaver’s file
menu.
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Choose “My Portfolio Web Site” from the list (or
whatever you called your site when you first
defined it), then select “Edit...”.

This opens the site definition dialog box and it is likely that
the site definition wizard will open, as indicated by the “Ba-
sic” tab in the upper left hand corner.  However, we are go-
ing to use the “Advanced” section instead. Don’t worry, it’s
not really that advanced!  Instead of taking us through all
of the parts page by page, we can quickly enter all of the
information we need for our remote site on one page.

Click once on the tab marked “Advanced”.

Choose “Remote Info” from the list of categories
on the left side.

Your screen should now resemble the following:

We need to tell Dreamweaver how we intend to access our
site. The most typical way is via FTP (file transfer protocol)

Click on the triangle graphic beside “Access:”
to show the pop-up menu.

Select “FTP” from the list.
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After you choose FTP, Dreamweaver displays the required
information fields:

Entering the correct information is critical here. There is no
room for error.  You might even have to use some “trial and
error” to identify the correct information for all the fields.

Here is the window completed properly for my ARCHES
web server account at the University of Georgia:

Let’s explore each of the entries, one by one.
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The FTP Host is the name of the web server and is almost
always the same name as the top most level of the HTTP
address.  Interestingly, in my case, the name is not exactly
the same — the “www.” is missing at the beginning and it
won’t work any other way. If you can’t discover the correct
name on your own, you will need to check with your web
server administrator for this information.

The Host Directory is the name of the directory on your
web server into which all of your web files must be located.
Many servers use “public_html”. Other typical names are
“www” and “wwwroot”. Again, if these don’t work, check with
your web server administrator.

Your Login and Password were given to you when you set
up your server account.  For many students, these are the
same Login and Password that they use to check their email
on this account.

Leave the other options on this page unchecked.

That’s it. Let’s test the connection to our remote server.

Click “Test”.

If successful, you will see the following message:

If unsuccessful, you will see one of several possible mes-
sages. For example, this message indicates that you have
entered the wrong FTP host:

This one indicates that either your log-in username or pass-
word is incorrect:

Cross your fingers
while you do this to
hope that you entered
everything correctly!
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Finally, this one indicates that you have entered the wrong
host directory:

If your connection did not work, you will need to edit your
site to revise the connection information.

It can take a few tries to get it all right.  The beauty of
Dreamweaver is that once you set up a site properly, it will
store this information permanently in your computer’s sys-
tem files. So, if you are using your own computer for all of
your Dreamweaver work, you only have to go through this
site definition process once.  If  you are working on more
than one computer, you will have to define the site for each
computer.

Click “OK”.

This sends you back to the list of sites.

Click “Done”.

Even though things don’t look much different than they were
before, there is a world of difference at this point — you are
now in the position to upload your files directly to the web
server!

Uploading could not be easier.  It is just a matter of select-
ing the files or folders, then clicking the blue up arrow, offi-
cially called the “put files” button. But before we do so, let’s
take a look at our remote server.

You can choose to view the remote server by choosing “re-
mote” view from the site panel window. But, I recommend
we go ahead and look at both the local and remote files at
the same time by clicking on the “expand/collapse” button
on the far right of the site panel (it looks like a small
notepad).

This error message,
at least, gives a hint
as to the problem.
Notice that I
mistakenly typed an
“n” instead of an “m”
in “public_html”.
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Click once on the “Expand/Collapse” button in
the site panel.

If you get a pop-up message saying that “the site map can-
not be built...”, just ignore it by pressing “Cancel”.

Your screen should resemble the following:

This is a split window. On the right hand side are our local
files and the remote files will be on the left.  The left side is
blank because we do not have a live connection yet with our
web server. Let’s initiate the connection.

Click on the “Connect to remote host” symbol.

This symbol looks like two disconnected plugs:

If you correctly entered all of the necessary information,
Dreamweaver will correctly connect to your remote server
and list all of the files associated with the host directory on
the remove server:

One thing that is important to notice is that the remote

Click here
Get the metaphor?

Click here
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host directory (i.e. “public_html” in my case) corresponds
with the folder “My local web files” on your computer (though
you will need to click once on it to reveal the complete path):

This is perfect.  All of your remote files for all of your web
site, present and future, will reside in your remote host di-
rectory just as all of your local files are stored in the folder
“My local web files” that we created at the beginning of this
guide.

Uploading Your Web Site to a
Remote Web Server

To upload any or all of your site to the remote server, you
merely click on the file/s or folder/s you want to upload, then
click on the “Put File(s)” symbol (the blue up arrow). We’ll
go ahead and upload the entire site at this point.

Select the “portfolio” directory in your Local
Folder (right) side of the site window, then click
on the “Put File(s)” symbol.

Dreamweaver asks you if you want to include “dependent
files”:

Dependent files are things like images and sounds that are
linked to this page. This is a handy option if you made sig-
nificant modifications to the page, such as adding more
graphics, Dreamweaver will automatically upload all the
graphics, sounds, etc. that are linked to this page to the
server for you. But, if you know you only changed the text,
which is very typical, you can click no.
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Click “No”.

Dreamweaver then uploads (puts) all of the selected files to
your server.  You will see a dialog box like the following as
the files are transferred:

 When finished, Dreamweaver automatically refreshes the
Remote Site (left) side of the site window:

You are now on the web! Let’s test it with Internet Explorer
or Netscape to be sure everything is really on the Internet.

Testing Your Site

Launch either Internet Explorer or Netscape
Navigator and enter the URL of your web site.

Here again is the URL for my portfolio on the ARCHES
server at the University of Georgia:

http://www.arches.uga.edu/~lrieber/portfolio

Obviously, you should type the URL of your web site.

Notice that I did not enter the file name “index.htm” at the
end.  It was not necessary to do so because this is the spe-
cial default name for a web file on this particular server.  If
I had used any other name for this file, I would have had to
type the file name.  Obviously, only one file per directory
can have this special name, so it is reserved for the home
page of that directory.
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If you uploaded your web site correctly and entered the URL
without a single error, it will appear in the browser win-
dow:

Using the Site Window to Manage
your Site

You can update your web site, or any portion of it, as often
as you like using Dreamweaver.  For example, after pre-
viewing my home page, I decided I didn’t like the textured
background after all. So, I double-clicked on the file
“index.htm” in my local view and deleted the background
image. It certainly doesn’t make sense to upload the entire
web site again just to reflect this one change. All I had to do
was click on the “put files” button (blue up arrow) that ap-
pears at the top of the file window, then choose “Put” from
the list:
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I forgot to save the file first, but fortunately Dreamweaver
prompts me to do so:

My web site has been immediately been updated. To check,
I go back to Internet Explorer. If the window is still open, all
I need to do is click the Refresh button:

I could also have uploaded just this one file via the site panel.

Other Useful Site Management
Features

There are a variety of other useful features you can access
from this window.

You can refresh your local folder and remote site by click-
ing on the Refresh symbol (blue circle with arrow).

Of course, you can download files from the server to your
disk with the “Get File(s)” symbol (downward pointing green
arrow). Of course, you have to be very careful when doing
this as this will overwrite your local file.
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Dreamweaver also one clever site management tool, called
Synchronize”, to allow you to quickly update all files that
have recently changed. The Synchronize feature can be found
in the Site menubar:

Finally, one other useful tip concerns how to create a new
directory using just Dreamweaver. This is not obvious be-
cause there is no such command in any of the file menus.
But, pressing the keys “ctrl-shift-alt-n” will do the trick. (Be
careful that you first select the directory into which you want
a new file or directory to be placed.)

Given these powerful site management tools, you should be
able to quickly build and maintain the most sophisticated
of web sites.


